Advanced Highway Maintenance and Construction Technology Research Center
Department of Mechanical and Aerospace Engineering
University of California at Davis

Caltrans Workflow for NavisWorks

Vaibhav Soni, Kin Yen, Ty Lasky, Ph.D.,
and Bahram Ravani, Ph.D., P.I.

Report Number:
AHMCT Research Report: UCD-ARR-11-10-31-01
Interim Report for Contract: 65A0368

October 31, 2011

California Department of Transportation
Division of Research and Innovation
This report provides a recommended Caltrans workflow for NavisWorks. Autodesk® Navisworks® is a comprehensive project review solution that supports analysis, simulation, and communication of design intent and constructability. Multidisciplinary design data created in a broad range of Building information Modeling (BIM), digital prototype, and construction project applications can be combined into a single integrated project model. Clash detection tools help design and construction engineers anticipate and avoid potential problems before construction begins, and minimize expensive delays and rework. Navisworks Manage, which is a part of the Navisworks suite combines spatial coordination with the project schedule to deliver 4D simulation and analysis. Entire project models can be published and viewed in NWD and DWF file formats.
Abstract

This report provides a recommended Caltrans workflow for Navisworks. Autodesk® Navisworks® is a comprehensive project review solution that supports analysis, simulation, and communication of design intent and constructability. Multidisciplinary design data created in a broad range of Building information Modeling (BIM), digital prototype, and construction project applications can be combined into a single integrated project model. Clash detection tools help design and construction engineers anticipate and avoid potential problems before construction begins, and minimize expensive delays and rework. Navisworks Manage, which is a part of the Navisworks suite combines spatial coordination with the project schedule to deliver 4D simulation and analysis. Entire project models can be published and viewed in NWD and DWF file formats.
# Table of Contents

Disclaimer/Disclosure ................................................................................................................................... 9

List of Acronyms and Abbreviations ........................................................................................................... 10

Introduction ................................................................................................................................................ 11

   Navisworks Options ............................................................................................................................... 12
   File Formats .......................................................................................................................................... 13
   Workflow .............................................................................................................................................. 14

Chapter 1: Importing Files in Navisworks ................................................................................................... 17

   Converting units for dwg files: ............................................................................................................... 19
   Supported CAD and Laser Scan formats ................................................................................................. 21
   Object Enablers .................................................................................................................................... 21

Chapter 2: Moving Around the Model ........................................................................................................ 23

Chapter 3: Managing Models ...................................................................................................................... 25

   Selection Sets ...................................................................................................................................... 25
   Search Sets .......................................................................................................................................... 26
   Exporting and Reusing Search Sets ........................................................................................................ 29
   Navigating the Selection Tree ................................................................................................................ 29
   Exploring Selection Tree Options ......................................................................................................... 30
   Viewpoints .......................................................................................................................................... 32
   Saving Viewpoints .............................................................................................................................. 32

Editing Viewpoints .................................................................................................................................... 32

   Add Copy (copy Viewpoint). .................................................................................................................... 33
   Add Comment ....................................................................................................................................... 33
   Edit ....................................................................................................................................................... 33
   Camera ............................................................................................................................................... 34
   Motion ............................................................................................................................................... 34
   Saved Attributes ............................................................................................................................... 34
   Collision .......................................................................................................................................... 34

Creating Animations ................................................................................................................................... 35

   Using Record to Make Quick Animations ............................................................................................. 35
   Creating an Animation from Viewpoints .............................................................................................. 36
   Editing and Updating Animation ......................................................................................................... 37
# Table of Contents

- Exporting an Animation ................................................................. 37
- Using Sections .................................................................................. 38
- Shortest Distance ............................................................................ 40

## Chapter 5: 4D Sequencing with TimeLiner ........................................ 41
- Why 4D? ......................................................................................... 41
- TimeLiner-Overview of all Toolbars ............................................. 42
- Adding Task Manually .................................................................. 45
- Auto-Adding Tasks ....................................................................... 46
- Linking In External Project Schedules ............................................ 47
- Linking the tasks to the model using manual selections............... 47
- Attach Current Search ................................................................... 48
- Attach Sets ................................................................................... 48
- Adding Comments ......................................................................... 49
- Designating Task Types ................................................................. 49
- Using the Configure Tab ................................................................. 49
  - Using the Simulate Tab ................................................................. 50
  - Simulation Settings ..................................................................... 50
  - Exporting TimeLiner Simulations ............................................... 53
  - Clash-detection .......................................................................... 54
- Starting Clash Detection ................................................................. 54
  - Working With Rules In Clash Detective .................................... 56
- Creating New Rules ....................................................................... 56
- Clash Object Selection ................................................................. 57
- Geometry Type and Self Intersect .................................................. 58
- Time-Based Clash ....................................................................... 61

## Chapter 6: Programming Tools ......................................................... 62
- Extending Navisworks to External Applications ............................ 63
  - Interacting with NWNavigator: .................................................. 63
  - Exporting to Google Earth ......................................................... 63
  - FBX ......................................................................................... 68
- Software Updates ......................................................................... 69
- Some other tips and tricks .............................................................. 71
LIST OF FIGURES

Figure 1: A typical Window in Navisworks ................................................................. 12
Figure 2: File Integration System in Navisworks ....................................................... 13
Figure 3: Workflow Progression for Navisworks ....................................................... 14
Figure 4: Graphics Card Control Panel Settings (top and bottom) ............................ 15
Figure 5: 3D settings for Navisworks ..................................................................... 16
Figure 6: Workflow Progression .............................................................................. 17
Figure 7: List of all file formats Navisworks can read ............................................ 17
Figure 8: HUD Icon in View Tab ............................................................................ 18
Figure 9: Changing Units in Navisworks ............................................................... 18
Figure 10: Changing Units in Navisworks .............................................................. 19
Figure 11: Changing Units from Selection Tree ..................................................... 20
Figure 12: Accessing Scene Statistics from the ribbon .......................................... 21
Figure 13: Missing object enablers listed in the Scene Statistics dialog box .......... 22
Figure 14: Workflow Progress .............................................................................. 23
Figure 15: Navigation Bar .................................................................................... 23
Figure 16: Steering Wheel with the full navigation wheel ........................................ 23
Figure 17: Walk Option ....................................................................................... 24
Figure 18: Workflow Progress ........................................................................... 25
Figure 19: Click Sets in the Select & Search panel ................................................ 25
Figure 20: A Selection Set is created ..................................................................... 26
Figure 21: Selecting Objects for Creating Selection Sets ........................................ 26
Figure 22: Properties window showing the interior door properties .................... 27
Figure 23: Properties window (left) for Creating Search Sets ................................ 27
Figure 24: Find Items window showing the list of appended models .................... 28
Figure 25: Adding Items to Search Set ................................................................... 28
Figure 26: Choose Search Sets from the Export Data panel .................................... 29
Figure 27: Visibility icons in the Home Tab .......................................................... 30
Figure 28: Alternative way of hiding Objects using Selection Tree ....................... 31
Figure 29: Saving Viewpoints ............................................................................. 32
Figure 30: The Saved Viewpoints palette context menu ....................................... 32
Figure 31: Adding Comments to a Viewpoint ....................................................... 33
Figure 32: Select Edit Viewpoint to Change the Viewpoints ................................... 33
Figure 33: Edit Viewpoint Current View dialog box ............................................. 34
Figure 34: The Record button is located on the Animation tab ............................... 35
Figure 35: Recorded Animations in Animation Tab ............................................... 35
Figure 36: Adding Animation in Navisworks ....................................................... 36
Figure 37: Context menu located on the Saved Viewpoints palette ....................... 37
Figure 38: Animation Export dialog box .............................................................. 38
Figure 39: Click on Enable Sectioning .................................................................. 38
Figure 40: Section tools panel

Figure 41: Viewing Different Layers and Completion Stages

Figure 42: Cross Section of Antler Bridge

Figure 43: Measure Tab for Measuring Dimensions

Figure 44: Distance Measurement

Figure 45: Workflow Progress

Figure 46: TimeLiner Window in Navisworks

Figure 47: Steps for Creating a TimeLiner Schedule

Figure 48: Click on TimeLiner icon in Home Tab

Figure 49: TimeLiner Interface showing the Tasks tab

Figure 50: Available TimeLiner columns

Figure 51: Modifying Rules for TimeLiner Simulation

Figure 52: Select Add Task from the context menu

Figure 53: Inserting Task in TimeLiner

Figure 54: Linking External File

Figure 55: Attaching Objects to Activity

Figure 56: Configure tab with Early and Late color settings

Figure 57: Simulation Settings dialog box

Figure 58: Interval dropdown menu

Figure 59: Overlay Text dialog box

Figure 60: TimeLiner View options

Figure 61: Exporting Simulation as Video File

Figure 62: Clash Detection (Above and Below) Window in Navisworks

Figure 63: Clash detection rules

Figure 64: Clash Detective showing the Select tab

Figure 65: Run panel of Clash Detective

Figure 66: Clash Detection Window

Figure 67: Classifying Clash Detection Results

Figure 68: Options in the Clash Display area

Figure 69: Settings for Exporting to Google Earth

Figure 70: View of Antler Bridge in Google Earth

Figure 71: Model of Antlers Bridge

Figure 72: Different Views of the Antlers Bridge as seen in Google Earth

Figure 73: FBX export options

Figure 74: New File format in Service Pack 1

Figure 75: Collaborative tab on Navisworks Service Pack 1
Disclaimer/Disclosure

The research reported herein was performed as part of the Advanced Highway Maintenance and Construction Technology (AHMCT) Research Center, within the Department of Mechanical and Aerospace Engineering at the University of California – Davis, and the Division of Research and Innovation at the California Department of Transportation. It is evolutionary and voluntary. It is a cooperative venture of local, State and Federal governments and universities.

The contents of this report reflect the views of the authors who are responsible for the facts and the accuracy of the data presented herein. The contents do not necessarily reflect the official views or policies of the State of California, the Federal Highway Administration, or the University of California. This report does not constitute a standard, specification, or regulation.
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHMCT</td>
<td>Advanced Highway Maintenance and Construction Technology</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>BIM</td>
<td>Building Information Modeling</td>
</tr>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>Caltrans</td>
<td>California State Department of Transportation</td>
</tr>
<tr>
<td>DGN</td>
<td>Design file supported by Bentley Systems’ MicroStation</td>
</tr>
<tr>
<td>DRI</td>
<td>Division of Research and Innovation</td>
</tr>
<tr>
<td>DWF</td>
<td>Design Web Format</td>
</tr>
<tr>
<td>GB</td>
<td>Gigabyte</td>
</tr>
<tr>
<td>MB</td>
<td>Megabyte</td>
</tr>
<tr>
<td>NWC</td>
<td>Navisworks Cache</td>
</tr>
<tr>
<td>NWD</td>
<td>Navisworks Document</td>
</tr>
<tr>
<td>NWF</td>
<td>Navisworks File Format</td>
</tr>
<tr>
<td>OS</td>
<td>Operating System</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>UCD</td>
<td>University of California-Davis</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>XML</td>
<td>eXtensible Markup Language</td>
</tr>
</tbody>
</table>
Introduction

Autodesk® Navisworks® is a comprehensive project review solution that supports analysis, simulation, and communication of design intent and constructability. Multidisciplinary design data created in a broad range of Building information Modeling (BIM), digital prototype, and construction project applications can be combined into a single integrated project model. Clash detection tools help design and construction engineers anticipate and avoid potential problems before construction begins, and minimize expensive delays and rework. Navisworks Manage, which is a part of the Navisworks suite combines spatial coordination with the project schedule to deliver 4D simulation and analysis. Entire project models can be published and viewed in NWD and DWF file formats.

Navisworks was selected for this report on Caltrans workflow as it is currently the only product of its kind that can produce the range of deliverables that Caltrans needs, including animations.

A typical Navisworks window is as shown below:
Navisworks Options

Option Editor is used to change the program settings from Navisworks. The settings are retained across different Navisworks sessions. Click on the Icon on the top left corner of the window and select option. You would observe a window as shown below:

![Figure 2: Click on Icon: N](image)

Some of the common settings in Options Editor (on the left side of figure 3) are described below:

**GENERAL**

Use the General settings to adjust the buffer size, file locations, and Auto-Save options

**INTERFACE**

Display Units: changes the Navisworks display units.

Selection: Configures the way geometry is selected and highlighted within Navisworks
Measure: Use these options to adjust for the Measure tools

Snapping: Enables snaps within Navisworks (Vertex, Edge, and Line Vertex). Enabling this is useful in conjunction with Measure tools

Other options include Links, Quick Properties, Developer settings, Display, Space Mouse, Navigation Bar, ViewCube, Steering Wheels, and User Interface.

NOTE: For detail description of each toolbar and its options please refer the book [1]

**File Formats**

NWD is a the basic file format that contains all geometry, relevant object properties, and clash tests, as well as any mark up, comments, and viewpoint information. NWD captures the conditions or milestone events. This includes clash tests and 4D simulations. The file size of most NWDs is considerably smaller compared to the corresponding CAD format. But NWD files do not update or re-cache if changes have been made to the original source data.

NWC: They are read only files and can be thought of as a transfer mechanism to convert CAD, Autodesk Revit, and other model data into a format that Navisworks recognizes. All geometry, relevant object property information, and display settings from the original source files will carry over with the NWC export. When the native CAD format file is first brought in, Navisworks creates a file with the same name but with the .nwc file extension in the same directory as the original source file. Once the file is opened in Navisworks, and changes made- such as redlines, markups, viewpoints, or display overrides- cannot be saved back to this format

Besides the link, NWF files contain such items as markup data, viewpoints, comments, graphical overrides, search/selection sets, Time Liner and Clash Detective Data. File size of NWFs is extremely small as compared to the NWC/NWD formats. NWF is dynamic and allows for easy updating of design changes from the original source files.

OTHER SUPPORTED FILE TYPES: AutoCAD, 3dStudio, DWF, IFC, IGES, inventor, Informatrix MAN, JT open, Parasolids, Pro-E, RVM, Sketch up, STEP, STL, VRML

![Figure 4: File Integration System in Navisworks](Copyright 2012, AHMCT Research Center, UC Davis)
**Workflow**

Basic workflow is as shown below. The basic approach is to import the files in Navisworks followed by use of various tools for 4D project management.

It can be summarized as follows:

![Workflow Diagram](image)

Figure 5: Workflow Progression for Navisworks

**Hardware Requirements**

- Microsoft® Windows® 7 Enterprise, Ultimate, Professional, Home Premium, or Home Basic edition, Microsoft® Windows Vista® Enterprise, Ultimate, Business, Home Premium, or Home Basic edition (SP2 or later), or Microsoft® Windows XP Professional Home 32-bit (SP2 or later) or Professional x64 edition (SP3 or later)
- AMD Athlon™ processor, 3.0 GHz or faster, or Intel® Pentium® 4, 3.0 GHz or faster (recommended)
- 4 GB RAM (8 GB recommended)
- 40 GB free disk space for installation and working with point cloud data
- 1280 x 800 VGA display with true color (1,280 x 1,024 monitor and 32-bit video display adapter recommended)
- Microsoft® Internet Explorer® 6.0, (SP1 or later)
- Microsoft Mouse-compliant pointing device
- Dedicated Graphics Memory: 1 GB (Recommended)

**Settings for 3D in Navisworks**

Recommended hardware:

- Graphics Card: NVIDIA Quadro 4000
- Monitor: Acer GD235HZbid Widescreen 23.6" 3D LCD Display
- NVIDIA 3D Vision Wireless Glasses Kit
- GPU Settings: After installation click on NVIDIA control panel and check for the following settings and enable/disable them as shown:
Figure 6: 3D Settings for Quadro 4000

Scroll down to check the remaining settings as shown below:

Figure 7: Graphics Card Control Panel Settings (top and bottom)

- Once the settings are done, open a NWD/NWF file. Click on View and Enable Stereo as shown
Use the 3D Glasses (NVIDIA 3D Vision) to see the viewer in 3D!

The depth of the 3D can be increased manually by scroll bar in Emitter or by using the software settings.

Figure 8: 3D settings for Navisworks

NOTE: Please ensure that the drivers for the Graphics Card are installed before the installation of the Navisworks Software. If the drivers are installed later, then Navisworks Software needs to be reinstalled.
Chapter 1: Importing Files in Navisworks

Figure 9: Workflow Progression

- Click on Append Icon as shown in figure below:

![Append Icon](image)

Figure 10: Append Icon for importing file in Navisworks

- Select the appropriate file format

![List of file formats](image)

Figure 11: List of all file formats Navisworks can read

Copyright 2012, AHMCT Research Center, UC Davis
After importing multiple files containing different objects, if a particular object is not visible in the view it need to be transformed inside the scene. This is done by right-click on the object which is required to be moved.

Click on HUD icon and select the xyz axes and Position Read out. This is required to read the coordinates.

![Figure 12: HUD Icon in View Tab](image1)

Select Units and Transform by right clicking on the object as shown below in figures 8 and 9.

![Figure 13: Changing Units in Navisworks](image2)
Figure 14: Changing Units in Navisworks

- Specify the required co-ordinates where the object is required to be moved

**NOTE:** Most current Navisworks model is shared among the entire team as an NWF with the associated source files for the external design reviews. Navisworks assists with the review process by providing mark up tools such as redline and comments. Since all the models contain one set of geometry, the only differences are any comments made by the different disciplines. The merge command allows these multiple reviewed models to be combined into a single file. Any duplication of geometry is removed, so the final file contains one set of geometry and all of the markups and comments from the different reviewers. THIS ONLY WORKS FOR NWF FILES. The Merge command will function like the Append command with NWD files and ultimately display duplicates.

**Converting units for dwg files:**

- Often it is found the units of the different objects (which are imported from different file formats) are not consistent with the units even though the settings are changed in the option menu.
- In such cases, use the following steps:
  1. Import a particular drawing.
  2. Click on Properties Tab
  3. Select Items and click on Units
  4. Change Units accordingly
Figure 15: Changing Units from Selection Tree
Supported CAD and Laser Scan formats

Table 1: Different File formats in Navisworks

<table>
<thead>
<tr>
<th>FORMAT</th>
<th>EXTENSIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navisworks</td>
<td>.nwd, .nwf, .nwc</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>.dwg, .dwf</td>
</tr>
<tr>
<td>MicroStation</td>
<td>.dgn, .prp, .prw</td>
</tr>
<tr>
<td>3D Studio</td>
<td>.3ds, .prj</td>
</tr>
<tr>
<td>DWF</td>
<td>.dwf, .dwfx, .w2d</td>
</tr>
<tr>
<td>FBX</td>
<td>.fbx</td>
</tr>
<tr>
<td>IGES</td>
<td>.igs, .iges</td>
</tr>
<tr>
<td>ASCII laser file</td>
<td>.asc, .txt</td>
</tr>
<tr>
<td>Faro</td>
<td>.fls, .fws, .iQscan, .iQmod, .iQwsp</td>
</tr>
<tr>
<td>Leica</td>
<td>.pts, .ptx</td>
</tr>
<tr>
<td>Riegl</td>
<td>.3dd</td>
</tr>
<tr>
<td>Trimble</td>
<td>Native file not supported; convert to ASCII laser file</td>
</tr>
</tbody>
</table>

Object Enablers

Opening and appending different file types is fundamental goal in Navisworks. Autodesk applications such as the AutoCAD platform (Architecture, Civil 3D, and Plant 3D) and other software vendors use the ObjectARX (AutoCAD Runtime Extension) application to generate graphical and non-graphical custom objects. Thus object enabler is a translator that converts custom objects into that format Navisworks recognizes. The best way to make sure that object enabler is present is to check the scene statistics for the current scene.
If the object enablers are missing from the current scene, they will be recorded in the list along with which file they are missing from. If they are absent one need to configure the software which was used for configuring the drawing!
Chapter 2: Moving Around the Model

The Navigation Bar contains ViewCube, SteeringWheel, Pan, Zoom, Orbit, Look, and Walk/Fly tools.

**Zoom**: for zooming to a particular window

**Steering Wheel**: The options available in steering wheel are pan, Zoom, Orbit, Rewind, Center, Walk, Look, Up/Down, Wheel Views, Home and Fit to Window, Camera Controls. The first four options are...
same as Navigation bar. **Rewind tool** is used to locate views from the navigation history so that we can restore a previous view through all the saved views. **Center tool** is used to define the center of the current view of the model. Up/down option changes the elevation, similar to **Tilt Angle tool**. **Wheel view** allows changing the level of the steering wheel. **Camera Controls** enables to increase or decrease the Walk tool speed.

**Walk Tool:** This is used for navigating in the scene. It offers various options as seen below in figure 13. Place the walk tool on the scene where you want to observe the structure. By left clicking on the scene and moving the walk pointer along the scene, the user can navigate in the scene similar to a real environment

**Fly:** For flying around the scene and perspective from a birds-eye view of your model. It works similar to walk tool but offers a

**Collision:** Enables collision with the object while navigating

**Gravity:** Gives the appearance of weight. When using the walk tool and you began to move, you will ‘fall’ until you reach a surface. Gravity works best when collision is also active so that when a surface is contacted the falling stops. Use Gravity in conjunction with Collision to walk up and down stairs, for example. Gravity must always be paired with collision.

**Crouch:** Enables the avatar to crouch automatically under objects where it cannot walk freely while navigating

**Third Person:** It turns on the third person view, or an avatar, which may be used as a representation of you while navigating the model.

![Figure 21: Walk Option](image)
Chapter 3: Managing Models

In this module we will learn to:

- Create Search and Selection Sets
- Export and reuse Search Sets
- Navigate the selection tree

Selection Sets
Selection sets are the easiest way to remember groupings of objects in your model. The advantage is instead of manually searching for a specific object, you select the Selection Set and Navisworks will highlight the saved grouping of objects in your model.

- Open the Sets window by selecting the Home tab, choosing the Select and Search Panel and Clicking Sets as shown below:

  ![Click Sets in the Select & Search panel](image)

- Select Manage Sets from the bottom of the drop-down menu to open the Sets window. This is a dockable window, so you can pin it open and have it floating in Navisworks scene.
- Select desired objects holding Ctrl key
- In the Sets window, right-click and select “Add Current Selection”. Navisworks will add an icon of a circle with Blue Square. In the figure below, a selection set of Piers is created.
Search Sets

Search Sets are similar to selection sets, but instead of manually selecting the objects in Navisworks scene, you can leverage the object properties of the model to identify specific objects. When you run a query of the model with specific criteria, Navisworks will highlight all relevant objects. You may save this grouping as a Search Set.

The main benefit of a search set is that every time we highlight the grouping, Navisworks will conduct a search of the model to identify any components that match your criteria.

The steps are as follows:

- Open the Sets and Properties windows
- Locate the Find Items command on the Select and Search panel of the Home tab. Make sure the Find Items and Properties windows are pinned open so you can access them easily
- Navigate to the inside of the model and select any objects
- Keep the object/s selected and in the Properties window, select the Element tab and note the value for the property Labeled category. If you’re not seeing the Element tab, look in the selection tree to make sure you’re referencing the parent object and not the sub-objects.
The next step involves using this information for the search criteria. It’s important to note that some model objects may not have as much property information, so you may need to identify other property categories to use for identification.
The Find Items window contains some duplicate elements from the Navisworks interface. On the left side of the window is a listing of all the appended models in our scene. When you conduct a search for a specific item, you can direct Navisworks to focus on specific file as shown in figure below. If no file is specified from the list, Navisworks will search through all models in the scene.

![Find Items window showing the list of appended models](image)

**Figure 28: Find Items window showing the list of appended models**

To save this as a Search Set, in the Sets window right-click and select Add Current Search. Name the Set. This is illustrated in the figure below:

![Adding Items to Search Set](image)

**Figure 29: Adding Items to Search Set**
The Options in Find Items are explained as follows:

**Category**: The first part of our object property hierarchy is the category. If you expand the drop-down for this option, Navisworks lists all the available categories from your entire model, unless you’ve selected specific models from the selection tree on the left side. In our Properties window, the category refers to the tabs along the top.

**Property**: The property tab lists all the available property names. This list varies and is determined by the selected category. In our properties window, this corresponds to the listing under the property heading.

**Condition**: This option let you select a condition operator (=, Not Equals, >, >=, <, <=).

**Value**: The value tab lists all property values for your search criteria. Just like the Property options, the Value drop-down entries will vary depending on the selection. The options in value tab mentions the criteria which would be used for creating search sets.

### Exporting and Reusing Search Sets
To export search sets, do the following:

- Open the .nwd file
- In the Output tab, choose Search Sets from the Export Data panel
- Specify the filename and location for saving
- Close the file and open a new .nwd file where the Search Set is to be used
- Choose Import ->Search Sets from the Application menu
- Select the save SML file
- Open the file and you will observe that Search Sets are added back to the Sets window

![Figure 30: Choose Search Sets from the Export Data panel](image)

### Navigating the Selection Tree
The selection tree displays the hierarchical listing of all files in your Navisworks scene based on the format they were originally saved in. Items in the selection tree are bidirectional with model display, so when an element is selected in the selection tree, the corresponding model object is highlighted, and vice versa. There are a total of four tabs in the selection tree but by default only Standard, Compact, and Properties are initially displayed.
**Standard:** This displays the default model hierarchy. The order shown is based on the loading sequence of the models. If you continue drilling down into hierarchy of the Architecture model, you start to uncover the individual components that reside in particular object.

**Compact:** The compact tab in the selection tree displays roughly the same information as the Standard tab, albeit a simplified version that omits some of the complexity. This feature is useful if your model contains numerous blocks or instanced groups that add additional levels to your hierarchy. By reducing the complexity, it becomes much easier to navigate within the selection tree.

**Properties:** The Properties tab provides a different type of model organization. When models are appended to Navisworks, all object properties are displayed in the Properties tab. The data displayed in the selection tree is based on the hierarchy of the Properties window.

**Exploring Selection Tree Options**

**HIDE**

The Hide command allows you to temporarily remove objects from your Navisworks scene to aid in viewing the obscured parts of the model. It is used as following:

- In the selection tree, choose the standard tab
- Select the .nwc file
- In the visibility panel located in the Home tab of the ribbon, select the Hide command, as shown below

![Figure 31: Visibility icons in the Home Tab](image-url)
To unhide the elements, simply click the Hide icon again
Expand the selection tree and try hiding a combination of elements using the Ctrl and Shift keys to select different groups of objects

**REQUIRE**

Require function is useful when you’re working with large models that are drain on system resources. Depending on the complexity of your model and system resources, when navigating a large model we may see flickering or, in some instances, portion of the model dropping out. This function allows you to specify which items will be prioritized when you’re navigating through the model.

Follow and same steps as in Hide function but instead of clicking on Hide, choose “Require”

Items set to “Require” will be listed in a red font for easy identification.

**NOTE:** Icons for Move, Rotate and Scale are used in making Animation which will be described later in this report.
Chapter 4: Model Snapshots- Viewpoints, Animation, and Sections

Viewpoints
Viewpoints are the snapshots of scenes in your model. They can contain information like redline markups, comments, tags, and measurements. In addition, a saved viewpoint serves as a navigation aid in that it can remember when you change things like transparency, color, and item displays (hide/unhide);

Saving Viewpoints
- Place the elements as desired in the scene
- Select the Viewpoint tab on the Save, Load & Playback panel and click the camera icon.
- The same can be done by right clicking in the scene and selecting Saved Viewpoints -> Saved Viewpoints -> Save Viewpoint from the context menu

Editing Viewpoints
- Select a viewpoint and press F2. Rename as needed
- Left-click the viewpoint. Pause, then left-click the same viewpoint again, and you can then rename the view.

Figure 33: Saving Viewpoints

Figure 34: The Saved Viewpoints palette context menu
**Add Copy (copy Viewpoint)**

The Add copy feature creates an exact copy of the selected viewpoint, allowing you to make changes as needed. Multiple viewpoints can be copied at once by selecting them with Ctrl key and then clicking Add Copy.

**Add Comment**

Opens the Add Comment dialog box where you can add comments to a viewpoint. The status of the comment can also be set at this time.

![Add Comment](image)

*Figure 35: Adding Comments to a Viewpoint*

**Edit**

The Edit Viewpoint command, also available from the Viewpoint tab in the Save, Load and Playback panel, gives access to the Edit Viewpoint – Current View dialog box, which contains the following options for enhancing an existing viewpoint.

![Edit Viewpoint](image)

*Figure 36: Select Edit Viewpoint to Change the Viewpoints*
Figure 37: Edit Viewpoint Current View dialog box

**Camera**

Camera allows you to change the existing viewpoint’s Position, Look At, Vertical Field of View, Horizontal Field of View, and Roll settings. *Look At* allows you to quickly change the focal point of the camera and Roll Settings.

**Motion**

It allows changing the existing viewpoint’s Linear and Angular settings. These settings can be useful for further refining the existing viewpoint.

**Saved Attributes**

Hide/required and Override Material applies to already saved viewpoints. These options allow you to save hidden/required markup information and material override information with the viewpoint. When a viewpoint is used again, the hidden/required and material override information that you saved is reapplied.

**Collision**

This option opens the collision dialog box, where you can change the Collision, Gravity, Crouch, and Third Person settings for existing viewpoints. This dialog box is a useful place for changing or enabling/disabling settings for these features on previously created viewpoints.
NOTE: Viewpoints can be exported as XML files using the Output tab

Creating Animations
There are two ways to create an animation in Navisworks. First we can use the Record features to record your movements as you go along, creating frames for each movement. Second, you can create a series of viewpoints and place them inside an animation.

Using Record to Make Quick Animations
To use Record, do the following:

- On the Viewpoint tab of the Save, Load & Playback panel, click Record
- At the right corner of the view point tab is a Recording drop-down that contains Pause and Stop controls. You can use the controls on the Playback panel as well.
- Use Navigation tools (walk and Fly) to move around model
- Use Pause to stop and readjust as needed. Doing so will create a “cut” in the animation for the duration of the pause. See “pause and cut” later in this chapter.
- Click stop when you have completed your navigation

After the animation has been created, it will be saved automatically in Saved Viewpoints under the Animation folder. Once recorded, the animation becomes the active animation in the Animations drop-down list located on the Playback panel of the Viewpoint tab.
Creating an Animation from Viewpoints

Another method for creating animations is by adding viewpoints to a blank animation. Using this method can sometimes be a little easier than using Record. The steps are:

- Go to the Saved Viewpoints palette and right-click. Select Add Animation from the context menu to add a blank or empty animation. This is where you will later add your viewpoints.

![Add Animation in Navisworks](image)

- Navigate around your model as needed to create your viewpoints. While it does not matter the order that you create your viewpoints, it will matter the order that they are added to the animation.
- Select your viewpoints to add to the animation. Use Ctrl+Shift to select multiple viewpoints. Drop them in the previously created blank animation.
- Viewpoints will be added in the order that they were dropped into the animation. To make changes or to change the order, drag and drop the viewpoints within the animation folders.
Editing and Updating Animation

Animations are played by selecting them from the Saved Viewpoints drop-down located on the Viewpoint tab of the Save, Load & Playback panel. Click on the drop-down and select the animation you want to play. Then use the controls to play, fast-forward, pause, and rewind as needed.

With the edit tools, you can change duration of playback, add pauses, and use some of the viewpoint tools like Transform and Update to further refine the animation.

Exporting an Animation

- Choose the Output tab and click Animation
- Click the Application button and chose Export ->Export Animation
- After clicking OK, you will be prompted for a save location

NOTE: For detail explanation about Animation Export and high quality rendering please refer the book.
Figure 42: Animation Export dialog box

Using Sections

Section in Navisworks enables to create various cross section views of the model. Besides providing feature of sectioning the model, it is possible to create multiple section planes. The steps are as follows:

- Open the .nwd file
- Open Saved Viewpoints and select the Sectioning viewpoint
- Go to the Viewpoint tab and in the Sectioning panel, click Enable Sectioning
- Enable Planes and Move, set Plane 1 as Active, and set Align to Top.
- Enable Plane 2 and set its Alignment to Left
• Move the Gizmo accordingly and observe the change in sections
Shortest Distance

- Using the Shortest Distance feature, we can determine the narrowest portion of the structure.
- Navigate to the select the viewpoint

![Figure 47: Measure Tab for Measuring Dimensions](image)

- Select the two structure using Ctrl key + Left click for which the shortest distance is required to be found out
- Click on Shortest distance
- If it is required to have it permanently, select ‘Convert to Redline’

![Figure 48: Distance Measurement](image)
Chapter 5: 4D Sequencing with TimeLiner

Figure 49: Workflow Progress

A 4D model acts as a visual interface between the Gantt chart and 3D model by displaying the associated model elements concurrently with the progression of construction activities over time. This allows us to quickly understand which areas of the model are being referenced by the schedule, but more importantly we can start to understand the context of multiple activities and quickly see which areas are impacted.

Why 4D?
Creating requests for information (RFIs) is a time-consuming process where additional information is needed typically once the project has started. This can be due to ambiguity or contradiction in the design drawings or differing site conditions that need to be further evaluated. The costs associated with RFIs vary, but as a result of the administrative costs to prepare and document, along with any potential downtime while waiting on an answer, costs of several hundreds of dollars are not uncommon. A 4D model is the common “language” between the owner, designer, and can eliminate scheduling conflicts that lead to delays and cost overruns.
Navisworks retains the same file format-agnostic approach with TimeLiner by allowing users to link in multiple schedules from numerous sources to view the potential impacts by visualizing the entire construction process and identifying inefficiencies early in the coordination review.

**Figure 50: TimeLiner Window in Navisworks**

**Figure 51: Steps for Creating a TimeLiner Schedule**
- Open the TimeLiner module by clicking the TimeLiner button in the Tools panel of the Home tab. TimeLiner is a dockable window that can be placed anywhere in Navisworks interface.

![Image of TimeLiner interface](image)

**Figure 52: Click on TimeLiner icon in Home Tab**

**Figure 53: TimeLiner Interface showing the Tasks tab**

- The topmost area controls the visibility of the columns and ways to filter the various schedule tasks.
- The Tasks tab is the first of the tabs in the TimeLiner window.
The lower-left area displays the schedule task names, start and end dates, and task types. On the right side, Navisworks re-creates the standard Gantt chart view.

The Tasks subarea can be broken down into two subgroups: the Tasks area and the Gantt chart area. We may also use Filter by Status options for filtering as per the different requirement.

The Column Set may also be adjusted depending upon the requirement.

**Figure 54: Available TimeLiner columns**

**Rules:** Rules are one of the great features in Navisworks that allow you to automate the linking of schedule data to the model elements. A 4D model is a 3D model plus attached schedule data (Time). Attaching the schedule data to numerous model objects is time consuming and inefficient. Using rules, we can auto link the model elements to the appropriate schedule task by using Search and Selection sets, or by the internal properties. Clicking the Rules button opens the TimeLiner Rules Editor, where we can specify defined rules or create our own.

**Figure 55: Modifying Rules for TimeLiner Simulation**
Adding Task Manually

Navisworks is a BIM simulation and analysis tool that teams up and augments existing scheduling applications. For creating a schedule from scratch perform the following operations:

- Open TimeLiner Window
- Right-Click in the gray area. The context menu as shown in figure below appears.

![Figure 56: Select Add Task from the context menu](image)

- Choose Add task from the menu. Navisworks will add a new task with blank dates
- In the Name column, rename the activity to Install Footings or a typical schedule activity name
- Select the Planned Start Column and adjust the dates to reflect the anticipated start date for this task
- Repeat this for the Planned End dates. Note that the Status column is still gray since you don’t have any actual dates to compare against
- Select the Actual Start field and enter dates for both the Actual Start and End. Experiment with adjusting the dates to notice how the status icon changes.
- After defining all the task names, planned start, planned end, actual start, and actual start, we may link the respective activity in Attached Column by using right click and selecting attach sets.

Note: Experiment with adjusting the dates to notice how the status icon changes. Also modification of dates can be done with the help of Gantt chart.
Another option when populating the Tasks window is to have Navisworks create the task names and add them automatically. These names are based on layer, item, or Selection Set names and encompass all of the appended files in your scene. The steps are:

- Open the TimeLiner window.
- Right-click in the empty portion of the tasks window.
- Select Auto-Add Tasks from the menu.

Options:

**For Every Topmost Layer:** Creates tasks with the same names as the topmost layer in the selection tree.

**For Every Topmost Item:** Creates tasks with the same names as each topmost item in the selection tree.
For Every Set: Selecting this option will create a separate task for every currently defined search and selection set utilizing the same naming convention.

Linking In External Project Schedules
The third method for adding tasks to the model is linking the data from an external schedule application. This process allows importing large amounts of data without the manual effort mentioned earlier. In addition to importing activity names and dates, most scheduling applications support custom fields that can be used to supplement additional information in the model. Items such as discipline, critical path, and other planning information can be mapped to user-defined fields in the TimeLiner interface and are quite useful while sorting or filtering the tasks. Navisworks currently supports the following applications:

- Microsoft Project 2003-2010
- Microsoft MPX
- Primavera Project Planner (P3)
- Primavera Project Management P4.1, P5.0, and P6.2 (SDK)
- Primavera P6 (Web Services)
- Primavera P6v7 (Web Services)
- Asta Power Project versions 7-10
- CSV files

The Data Sources tab contains three buttons: Add, Delete, and Refresh (as shown above). Once selected the appropriate files, a second dialog box will display asking you to select Rebuild or Synchronize. Select Rebuild if changes are made in the schedule. To preserve any manual changes made in the Tasks Window, select the second option Synchronize to the external schedule.

Linking the tasks to the model using manual selections
- There are three ways of working with manual selections: Attach Current Selection, Attach Current Search, and Attach Sets

  a) Attach Current Selection: Linking objects that have been highlighted in the model to a specific task in the Task window. This is used in cases where adding one-off item or easily...
accessible items is required. It is not to be used for linking numerous objects as the feasibility of this workflow is rendered useless by some of the other filtering tools in Navisworks.

Steps:

- In TimeLiner window select the Tasks tab
- Select the site objects by highlighting them in the model view window
- Locate the task in the Task window in TimeLiner
- Right-click on the same task and choose Attach Current Selection
- In the Attached column, note the field now contains the words Explicit selection

![Figure 59: Attaching Objects to Activity](image)

**Attach Current Search**

It is also possible to do the same selection using embedded object properties to define which model elements are selected for linking to the tasks. Here are the steps:

- Using the same file, click the Find Items command. Keep the TimeLiner tab open as well
- Conduct a model search for the following values:
  Category: Item
  Property: Name
  Condition: =
  Value:
- Keeping the results highlighted, navigate back to the Tasks tab in TimeLiner
- Locate the task
- Right-click on the arrow next to this task and select **Attach Current Search**

**Attach Sets**

- Right-click and select Attach Set from the context menu
- Navisworks will display a listing of all available search and selection sets in the model
- Select the required object
Checking the Model

After linking the model, double-check the work to make sure all model objects have been associated to a specific task. One option is to hide the elements in the model after they have been linked. At the end of linking session, any visible items in the model view that have been orphaned and are not currently linked to any specific task would be seen.

Adding Comments
- With the Tasks window open in TimeLiner, right-click on the small leftmost column and select Add comment from the context menu
- In comment dialog box, enter any text and select a status for the comment
- Navisworks will display the number of comments in the comments column in the Tasks window. You may need to enable this from the Column Set drop-down.
- To view the embedded comments, open the Comments window from the Review tab in the ribbon and highlight the specific task. All comments will be displayed, including Time/Date, Author, Comment ID, and Status

Designating Task Types
The final step in the process is to specify a task from the Task Type column in the Tasks window. The three default task types are Construct, Demolish, and Temporary. Choose the required task type depending upon the type of activity.

Using the Configure Tab
The Configure tab has two basic functions: defining custom task types and creating appearance definitions. When simulating the 4D model, it’s useful to know which elements are still under construction versus completed activities or which trades are currently working on portions of the site. It is also possible to have different appearances as the project progresses which may be grouped as:
- Start Appearance
- End Appearance
- Early Appearance
- Late Appearance
- Simulation Start Appearance

Steps:
- In the Configure tab, click the Add button. A new task names New Task Type is added to the Name Column
- Highlight the name and change it to Existing or something similar
- To change the appearance definition for a task type, double-click the Start Appearance field and select the definition from the drop-down
Using the Simulate Tab
When the simulate tab is selected, the animation will queue up for the first date defined in our 4D simulation. In this mode, any object that is scheduled at a later date is currently hidden from view. Switching back to Tasks view or toggling off TimeLiner will restore the hidden items. The Simulate tab shares features similar to those on the Tasks tab and also consists of 3 distinct areas.

- Topmost area: Basic Playback controls + Slider for skipping the simulation
- Lower area: Replicating the functionality of Tasks area and Gantt chart in the Tasks tab
- Hit F11 on the keyboard for Full Screen view

Simulation Settings
To access these configurations, click the Settings button in the Simulate tab. A new dialog box, as show below, would open:
The topmost area, Star/End Dates, allows you to override the current start and end dates of the simulation. These options are useful when we are importing schedules that have additional tasks that are not represented by any geometry in the model.

Items such as design, procurement, permitting, or any other activities prior to the Notice to Proceed (NTP) typically have no model elements that can be represented by these tasks. Overriding of Start/End dates is also possible.

The second area is used to configure the interval size of the simulation. Depending upon the type of simulation, the intervals are expressed as percentages which can be changed as shown below.
The middle of the Simulation Settings dialog box contains the Overlay Text setting. With this setting you can overlay the date information in the model view during the simulation. The drop-down menu on the right allows us to configure where the text is placed in the model view: None, Top, or Bottom. The Edit button allows us to specify which data is included in the text overlay.

The View setting is used to configure the display of differences between actual versus planned dates. Navisworks can handle both of these sets of dates to create comparisons and easily identify early and late schedule activities.
Exporting TimeLiner Simulations

To share a 4D simulation as a video (AVI only), we can export the model as either a shaded (OpenGL) or a fully rendered animation. The Anti-Aliasing option is used to smooth the edges in the model. Large values of this might take longer to export and hence the value should be ideally 4x. Also for professional video, the frame rate or FPS should be 25 or 30. The steps are as follows:

- Select the Output tab and click the Animation button in the Visuals panel of the ribbon
- In the Animation Export dialog box, select TimeLiner Simulation from the Source dropdown list.
- In the Renderer area, choose:
  - Presenter – To render the animation with applied materials and lights
  - Open GL – To export with basic shaded display

- Specify the output. If AVI is not selected from the list, Navisworks will generate hundreds of individual images
- In the Options box, specify the appropriate video compressor and compressor quality settings. The default setting is Full Frames (Uncompressed)
- In the Size area, specify the export size for the animation
- Specify the FPS setting and then give the path where the path is to be exported

Figure 65: Exporting Simulation as Video File

Copyright 2012, AHMCT Research Center, UC Davis
Clash-Detection

- Click on Clash Detection Icon in Home tab

Figure 66: Clash Detection (Above and Below) Window in Navisworks

Starting Clash Detection
The batch tab is essentially the starting point for clash detection. It gives a place to keep track of the saved clashes or batches.

**The Batch Tab**

**Name:** Each new batch item is added here with the default name of Test 1 which can be renamed.

**Status:** Displays one of the four available statuses of the listed batches and will change as batches are updated or run from the Select tab: New, Done, Old and Partial (interrupted clash analysis).

**Clashes:** Shows the total number of clashes in the batch.

**Clash Status:** They are of 5 types depending on how items and settings are adjusted in the Results tab. They are: New, Active, Reviewed, Approved, and Resolved.

**Adding to and Maintaining Batch Items:** Using Add and Delete selection. The *Compact* Option removes clashes and shortens the number of clash items available in the results. One rule about this function is that it will only remove resolved clashes that are not grouped in folders.

**Clean:** Resets all the clashes back to New.

**Clear All:** Removes all the clashes from the batch.

**Update:** Updates all the clash batches with the current settings. If new models have been loaded, new clashes will be performed in the background.

**Importing and Exporting Clash Tests:** Exporting as XML files.
WORKING WITH RULES IN CLASH DETECTIVE

Enabling rules when running a clash can help reduce or filter the number of clashes that we might have on a given run.

Creating New Rules

Click New to open the Rules Editor where we can select parameters from the existing rules templates. Once the template has been selected, one can edit the information in the Rule Description field.

Rules Templates:

There are eleven predefined rules templates that we can use. The first six are default rules and the remaining five are customizable rules templates where we can indicate our own information, such as Selection Sets or specific properties. One may even edit a rule by clicking the Edit button at the bottom of the Rules tab.

Steps:

- Open .nwd file wherein Clashing needs to be found out
- Open Clash Detective and select the Batch tab.
- Select the Rules tab and click New (if new rules are to be defined)
- Select Specified Selection Set (which might vary depending upon user) as rules template
- From the <set> selection, choose the required objects. Doing so filters out the slabs from the clash tests and to controls your results
- Click the check box next to the newly created rule
- Choose the Select tab and select Start to apply the new rule. The number of clashes would be reduced then compared to the previous case with no custom defined rules

**Clashing Objects**

![Clash Detective showing the Select tab](image)

Notice the panes labeled Left and Right in Clash Detective’s Select tab. Essentially the Left and Right panes are windows into Navisworks’ selection tree. The Left and Right panes allow you to select the items we want to clash in Navisworks. Both panes would be used to select the items which are to be clashed against each other.

Imagine your left and right hand in front of you and you clap your hands together! Essentially that is how we would describe the Left and Right panes.

**Clash Object Selection**

Steps:

- Open Clash Detective and choose the Select tab
- Make sure the standard option in the lower section of each pane is selected for both the Left and Right panes
- Click Start at the bottom of the tab to run the clash

The other possible options and their utility are as follows:
Standard: Default tree view. It displays a fair amount of information available for use in clash detection

Compact: Further simplifies the standard tree view

1. Properties: Shows Object Properties and allows you to select specific properties to clash against
2. Sets: Displays the defined items on the Sets tab, and allows to use them as items to Clash; works for both Search and Selection Set

Geometry Type and Self Intersect

Using the geometry type buttons included with Navisworks enables to change how objects are clashed against each other.

For instance, if we have a Laser Scan Data (Point Clouds) that is imported in Navisworks and we want to clash the data against some existing structure, we would select the Points Geometry Type option so that it can recognize point cloud. Other possible options are: Surfaces and Lines.

Select Current

It is used for selection of objects

Run Panel

![Figure 69: Run panel of Clash Detective](image)

**Type:** Hard Clash, Clearance Clash (for keeping objects apart), Duplicate Clash

**Tolerance:** This controls severity of the clashes and lets you filter out what could be considered minor clashes

**Link:** This allows us to link the clash test to a TimeLiner schedule or Animator scene

**Time Step:** Controls the time interval used when looking for clashes during a simulation

**Start Clash Detection:** Runs the clash test

**Found:** Displays the total number of clashed found in the clash test
Interpretation of Clash Results

Let us first understand the various options in Results Tab.

**Name**: Displays the name of clash

**Status**: Shows the current status of clash (New/Active/Reviewed/Resolved)

**Distance**: Displays the distance or depth of the actual clash

**Description**: Lists the type of clash found- Hard, Hard (conservative), Clearance, or Duplicate

**Found**: Lists the date and time the clash was most recently found

**Assigned To**: We may assign the clash results to specific team members for resolution.

**Clash Point**: It uses the coordinate system of Navisworks to pin point the location of each clash

**Start, End, and Event**: Used for time-based clashing, these fields link to the Events and Time fields in the assigned TimeLiner schedule and to help us to relate the clash back to a specific point in the schedule
Clash Groups enable to divide and group clashes in a manner that makes sense to the project.

**Clash Display:** These are the additional efficient ways to review the selected clashes. With these tools one can change how Navisworks displays the clash items with Transparent Dimming or *Hide Other*, take advantage of Animate Transitions, or use Save Viewpoints to save the change we might make to the clash view.
Switchback

This is a powerful tool that can aid in coordination meetings and design reviews, or helps us to return to a specific view in the native file. Essentially Switchback allows us to select an item from the Item 1 or 2 panes and switch back to the software program that it was created with. Switchback is available with AutoCAD, AutoCAD Civil 3D, AutoCAD Architecture, AutoCAD MEP, Autodesk Revit 2012 and MicroStation based applications only.

Time-Based Clash

Combining TimeLiner with the Clash Detective give the unique opportunity to monitor the project on timely basis. We can take into account items like cranes, bulldozers, materials that usually impact a schedule because they are moved around a site. Since these objects are often scheduled as temporary, demolished, or other schedule types (even construct), we may link them to Clash Detective to make sure they do not interfere with the project as they are moved around the jobsite.

Steps:

- Open a .nwd file
- Open TimeLiner, located on the Tools panel of the Home tab
- On the Tasks tab, look at the Planned Start dates for the First Floor Ductwork and First Floor Pipework
- Open Clash Detective and select an option in Batch tab from the list of clash results
- Select the Rules tab and make sure all the default boxes are checked
- Next, click the Select tab and select an option in left and right pane.
- In the Link drop-down, select TimeLiner; this will establish the link between TimeLiner and Clash Detective
- Click Start to begin the clash test. It may take a few moments for the sequence to complete since it’s running against the actual TimeLiner simulation
- Move over to the Results tab and scroll to the right to observe the Start, End and Event that the clash is now linked to (this information can also be exported to a report)
- Make sure that the Simulation box is also checked in the Display section of the Results tab. If the Simulation box is not checked, we will not be able to access the slider in TimeLiner
- Explore TimeLiner’s Simulate tab and use the slider to determine the potential impact in the schedule.

Report Types and Format: XML, HTML, Text, Current Test, All tests
Chapter 6: Programming Tools

.NET
Using the Navisworks .NET API, you can write custom plug-ins to Autodesk Navisworks products, drive Autodesk Navisworks from outside the GUI and automate certain tasks. You can also utilize the new .NET controls by embedding them in your own applications. For example, by creating an Autodesk Navisworks document viewer. Assemblies necessary to build your application are included in every Autodesk Navisworks product.

There are several advantages to implementing the .NET API for Navisworks:
- Programmatic access to Navisworks is possible
- Integrating with other Windows-based applications, such as Microsoft Excel and Word, is made dramatically easier by using an application’s native .NET API
- The .NET API is designed for both 32 bit and 64 bit operating systems
- The .NET API allows access to advanced programming interfaces with a lower learning curve than those for C++

There are three ways of using the .NET API with Autodesk Navisworks

- Plug-In – allows you to write additional functions that extend the Autodesk Navisworks product. Plug-ins are the main entry point for users working with the .NET API.
- Automation – allows you to drive the product from outside, to automate certain tasks and, crucially, invoke plug-ins.
- Controls – allows you to embed an Autodesk Navisworks file viewer into your own applications or to examine Autodesk Navisworks Documents without having the full Autodesk Navisworks program loaded.

Users of the Navisworks .NET API are able to:
- Gain access to Application information
- Gain access to Model / Document information
- Perform simple operations on Autodesk Navisworks documents (open, save, execute plug-in) without having to fully load the main application.
- Interoperate with the existing COM API¹

¹This is a legacy API. New development should use the .NET API whenever possible. The .NET API provides a COM API Interop interface for when functionality is only available in the COM API.

NwCreate
NwCreate is for creating Autodesk Navisworks models. You can use it to write exporters from third-party applications that create NWC files, or use it to write a loader for your own file format that integrates seamlessly into Autodesk Navisworks. It provides both C and C++ APIs, which means you can use it with any language that supports calling standard C functions. Tried and tested, this is the same API the Autodesk Navisworks team uses to write all the file loaders and exporters that ship with the product.
It supports creation of geometry, properties, text, viewpoints, selection sets, materials and textures, and lights. Geometry support ranges from basic faceted triangle meshes all the way through to support for B-rep entities including basic modeling operations such as union, subtract, intersect, extrude and revolve.

**Extending Navisworks to External Applications**

**Interacting with NWNavigator:**

Navisworks Navigator is commonly referred to as an AutoCAD Runtime Extension (ARX) plug-in as it allows creating a virtual session of Navisworks directly inside the CAD viewing window. This instance of Navisworks contains the same general navigation tools as the core application but allows swapping camera views between AutoCAD window and the dockable Navisworks window.

Steps:

1. Open an AutoCAD-based platform version 2004 and newer with the ARX plug in installed
2. Open the required .dwg file
3. Type NWNavigator at the AutoCAD command line. A new window will open inside the AutoCAD viewing window.
4. To create the same AutoCAD view in the Navigator window, click the Get AutoCAD viewpoint icon
5. Adjust the view in Navigator by using the navigation tools
6. To update the AutoCAD view with the Navigator view, click the Set AutoCAD Viewpoint icon
7. Close the Navigator window when complete to end the session.

**Exporting to Google Earth**

To assist with exporting the model to the correct coordinates, Navisworks uses a KML option editor to specify the Google Earth coordinates in tandem with the Navisworks model. The exported KML file contains the same model hierarchy, including most geometry (triangles and lines) as well as limited colors. Due to limitations of Google Earth, viewpoints and hyperlinks may be adjusted on export.
Figure 73: Settings for Exporting to Google Earth

There are two settings which we need to configure. The first, Export Model Relative to Terrain Height, is used to determine if the model is measured from the surface of the ground or from sea level. Keep the box checked to measure from the actual surface of the ground.

The second option, Collapse on Export, allows you to collapse the model hierarchy to different levels when exporting. The four choices are as follows:

**None**: The whole model objects are collapsed into one node

**All Objects**: All model objects are collapsed into one node

**Files**: Each distinct file is collapsed into one node

**Layers**: All layers in the model are collapsed into one node

For simplicity, it’s recommended that Layer option is used.
To keep Google Earth from becoming overloaded, we should limit the number of polygons in the export and hence select the Enable check box in the Limit Number of Polygons area in the top right to restrict the amount of geometry exported. A balance of 10,000 polygons yields good performance in Google Earth and maintains fidelity of the Navisworks model.

To align the Navisworks model, we must specify the origin position of the Google Earth surface. At least one set of points must be defined, but up to three different sets can be referenced for greater accuracy. In addition we need to specify reference points from the Navisworks model which would be positioned to exactly overlay the Google Earth position.

Enter manually the Longitude, Latitude, and Altitude. The other alternative would be importing a KMZ file. This would be generated by creating place markers in Google Earth that reference the origin and additional points and save them as KMZ files. To specify the Navisworks points, use the Pick button. When the cursor changes to cross hair, we may select the appropriate point in the model view to capture the reference point. Once the file is exported, it is not possible to change the view while the Google Earth export box is opened.

**Steps:**

1. Open the model and Google Earth’s KML Option dialog box
2. Make sure Export Model Relative to Terrain Height is checked
3. Set Collapse on Export to Layers
4. Enable Number of Polygons and set the value to 100,000
5. For the Google Earth origin point, click the Import button and navigate to the .kmz file. The coordinates from the place marker are now listed in the coordinate fields
6. Click the Pick button to specify the Navisworks reference point. With the crosshairs, select the edge of the required structure
7. For the Google Earth second reference point, select the Enabled check box and click the Import button. Navigate to the other .kmz file. The coordinates from that place marker are now listed in the coordinate fields
8. Click the Pick button to specify the Navisworks reference point. With the crosshairs, select the edge of the building
9. Click OK and save the KMZ file
10. Run Google Earth and open the previously save KMZ file.
Figure 74: View of Antler Bridge in Google Earth

Figure 75: Model of Antlers Bridge
Figure 76: Different Views of the Antlers Bridge as seen in Google Earth
FBX

FBX, or Filmbox as it’s sometimes referred to, is another format that allows you to export your Navisworks scene and reference in other applications such as 3ds Max. This is useful if we want to take the model in to a higher-end rendering solution than what the Presenter module provides. When exporting the FBX format, all model geometry (triangles and lines), materials, viewpoints, and lights are supported with the exception of point clouds.

Steps:

1. Open the FBX Options by clicking the FBX button in the Export Scene panel in the Output tab.
2. Depending on the size of the model, we may want to limit the amount of geometry exported. Click the Enabled check box and enter the number of polygons to limit in the export.
3. To include Texture, Lights and Cameras in the export, select the appropriate check boxes in the Include area.
4. In the Advanced Options area, specify the unit of measurement. Leave the FBX file format as Binary and specify the most current file version.

Figure 77: FBX export options
5. In the Texture area, click Embed to have the textures “baked” into the FBX file. If necessary, we can specify a separate location or the existing reference location.

6. Click OK and specify the filename and the location where we want to save.

With the FBX format, Navisworks scene can be imported for rendering applications such as 3ds Max or Maya to create high-end visualizations or advanced animations.

**Software Updates**

- Servicepack 1 for Navisworks was released in September 2011.
- Some more additional file formats have been added which allows interoperability in Navisworks.
- Autodesk Vault integration has been extended so that you can now access all supported file readers via the Vault (compared to the 2012 release product which was limited to Navisworks formats only).
A new Collaborate tab on the ribbon has been added providing access to the Autodesk Bluestreak desktop application (http://beyonddesign.typepad.com/posts/2011/09/interoperability-enhancements-for-navisworks-2012.html)
SOME OTHER TIPS AND TRICKS

High Quality Animations:
Here is the best method for getting great visuals out of Navisworks. It's a big process with an awesome outcome. Although it is bound to take time and lots of drive space for this. For the ultimate guide in resolution, use this chart to pick your output size:

http://en.wikipedia.org/wiki/File:Ve...Standards5.svg

In Navisworks, click 'Animation' in the output tab. Choose your size based on the desired chart from the image in the link above. If you have the time and processing power, you can try using a higher display resolution but ultimately use a final lower resolution for a faux HD look. The higher the resolution the larger your files will be.

Set your renderer to Presenter for a rendered view (Long Time) or Open GL. Open GL is the better option. Set your output to png. We are not making a video here but are actually making a collection of hundreds of still images. A three minute video will have roughly 1800 stills. The options tab on the output selection is a bit of a gamble so you may want to experiment with it before you shove a three minute 4D build through it.

Set your FPS (Frames per Second) to 10. (You need to set it to 10 when using iMovie 09, if you have access to Final cut or equivalent use 30 FPS. If you want the ultimate smoothness, use 60-90 FPS). Default setting is to use 10. Set your anti-aliasing to 2x or 4x, you may want to experiment here. Click ok and create a new folder in your destination folder, call it Render 1.

Go into that folder and save your file as '0001', this should number all your stills in sequence. Depending on the video length you may want to use four or five zeros. Using a thumb drive copy the folder to it and transfer the files to a Mac.

Now this part is time consuming, on the Mac Select the files (CMD+A), then copy (CMD+C), in a new project file paste them in. Make sure you have the ken burns effect turned off. Once in (5-10 minutes), select all images and click the inspector tool and set the clip length to .1 seconds then wait a few minutes. Once complete export your video.

Same objective can be achieved using windows movie maker for Windows 7/XP users by importing the images in the movie maker and running the video. One may also add sound files to create a movie-type animation.

Congrats, you have just made a 10fps video!!
References:

4. http://www.youtube.com/watch?v=0cZ0rrV4CAU&feature=related
5. For inserting models of beams, chairs, columns, desk, doors etc: http://seek.autodesk.com/
7. All updates on Navisworks Software: http://beyonndesign.typepad.com/posts/
8. For importing open source sketches of cranes, construction equipment, bridges: http://sketchup.google.com/3dwarehouse/
9. Free BIM Software for Clash detection: http://www.teklabimsight.com/helpcenter/takeATour.jsp (BIMsight does not provide tools for reporting or seamless tracking of changes over time)

Evaluation: As a replacement for firms using Navisworks Manage Clash Detective on small data sets that are *dwg or *dgn based it can be a useful tool in one's arsenal. For instance, a firm with Navisworks licenses could deploy this tool for project managers whom want to just review very specific data sets. This would free up a Navisworks license for other staff dealing with larger and more diverse data sets and needing the extra reporting and Timeliner scheduling features. In this regard, BIMsights place in your toolbox falls somewhere between the Navisworks Freedom Viewer and the old flavor of Navisworks (Navisworks Review). The lack of BIMsight's support for other file types (this is in part planned) other then IFC, DGN or DWG is a huge issue, especially with firms using Revit, Solidworks, or SketchUp. Moreover, point cloud support is lacking as is the ability to publish to Google Earth.